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Introduction

Introduction

This chapter provides information on the purpose of the manual, safety information, and additional
documents and resources.
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Purpose

Purpose

NOTE: The LTR-Style SmartMotor™ is intended for RoHS-exempt applications only — the LTR motors
contain lead-based solder on some internal components to achieve increased reliability over greater
thermal ranges.

The LTR-Style SmartMotor™ Installation and Startup Guide (the document you are currently reading)
provides an overview of the LTR-Style SmartMotor, along with information on unpacking, installation and
start up. This guide is meant to be used in conjunction with the SmartMotor™ Developer's Guide, which
describes the SmartMotor features, SMI software, programming, commands, and other topics related to
SmartMotor application development.

The information in this guide is meant to be used by properly trained technical personnel only. Moog
Animatics conducts classroom-style SmartMotor training several times per year, as well as product
seminars and other training opportunities. For more information, please see the Moog Animatics website or
contact your Moog Animatics representative.

Safety Information

This section describes the safety symbols and other safety information.

Safety Symbols

The manual may use one or more of these safety symbols:

WARNING: This symbol indicates a potentially nonlethal mechanical hazard, where
failure to comply with the instructions could result in serious injury to the operator or

major damage to the equipment.

CAUTION: This symbol indicates a potentially minor hazard, where failure to comply
with the instructions could result in slight injury to the operator or minor damage to the

equipment.

NOTE: Notes are used to emphasize non-safety concepts or related information.

Other Safety Considerations

The Moog Animatics SmartMotors are supplied as components that are intended for use in an automated
machine or system. As such, itis beyond the scope of this manual to attempt to cover all the safety
standards and considerations that are part of the overall machine/system design and manufacturing safety.
Therefore, this information is intended to be used only as a general guideline for the machine/system
designer.

Itis the responsibility of the machine/system designer to perform a thorough "Risk Assessment" and to
ensure that the machine/system and its safeguards comply with the safety standards specified by the
governing authority (for example, ISO, OSHA, UL, etc.) for the site where the machine is being installed
and operated. For more details, see Machine Safety on page 7.

Motor Sizing

It is the responsibility of the machine/system designer to select SmartMotors that are properly sized for the
specific application. Undersized motors may: perform poorly, cause excessive downtime or cause unsafe
operating conditions by not being able to handle the loads placed on them. The System Best Practices
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Environmental Considerations

document, which is available on the Moog Animatics website, contains information and equations that can
be used for selecting the appropriate motor for the application.

Replacement motors must have the same specifications and firmware version used in the approved and
validated system. Specification changes or firmware upgrades require the approval of the system designer
and may require another Risk Assessment.

Environmental Considerations

It is the responsibility of the machine/system designer to evaluate the intended operating environment for
dust, high-humidity or presence of water (for example, a food-processing environment that requires water
or steam wash down of equipment), corrosives or chemicals that may come in contact with the machine,
etc. Moog Animatics manufactures specialized IP-rated motors for operating in extreme conditions. For
details, see the Moog Animatics Product Catalog.

Machine Safety

In order to protect personnel from any safety hazards in the machine or system, the machine/system
builder must perform a "Risk Assessment", which is often based on the ISO 13849 standard. The
design/implementation of barriers, emergency stop (E-stop) mechanisms and other safeguards will be
driven by the Risk Assessment and the safety standards specified by the governing authority (for example,
ISO, OSHA, UL, etc.) for the site where the machine is being installed and operated. The methodology and
details of such an assessment are beyond the scope of this manual. However, there are various sources of
Risk Assessment information available in print and on the internet.

NOTE: The next list is an example of items that would be evaluated when performing the Risk
Assessment. Additional items may be required. The safeguards must ensure the safety of all personnel
who may come in contact with or be in the vicinity of the machine.

In general, the machine/system safeguards must:

« Provide a barrier to prevent unauthorized entry or access to the machine or system. The barrier must
be designed so that personnel cannot reach into any identified danger zones.

» Position the control panel so that it is outside the barrier area but located for an unrestricted view of
the moving mechanism. The control panel must include an E-stop mechanism. Buttons that start the
machine must be protected from accidental activation.

« Provide E-stop mechanisms located at the control panel and at other points around the perimeter of
the barrier that will stop all machine movement when tripped.

» Provide appropriate sensors and interlocks on gates or other points of entry into the protected zone
that will stop all machine movement when tripped.

» Ensure that if a portable control/programming device is supplied (for example, a hand-held
operator/programmer pendant), the device is equipped with an E-stop mechanism.

NOTE: A portable operation/programming device requires many additional system design
considerations and safeguards beyond those listed in this section. For details, see the safety
standards specified by the governing authority (for example, ISO, OSHA, UL, etc.) for the site
where the machine is being installed and operated.

» Prevent contact with moving mechanisms (for example, arms, gears, belts, pulleys, tooling, etc.).
« Prevent contact with a part that is thrown from the machine tooling or other part-handling equipment.

« Prevent contact with any electrical, hydraulic, pneumatic, thermal, chemical or other hazards that
may be present at the machine.

» Prevent unauthorized access to wiring and power-supply cabinets, electrical boxes, etc.
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Documentation and Training

» Provide a proper control system, program logic and error checking to ensure the safety of all
personnel and equipment (for example, to prevent a run-away condition). The control system must
be designed so that it does not automatically restart the machine/system after a power failure.

» Prevent unauthorized access or changes to the control system or software.

Documentation and Training

It is the responsibility of the machine/system designer to provide documentation on safety, operation,
maintenance and programming, along with training for all machine operators, maintenance technicians,
programmers, and other personnel who may have access to the machine. This documentation must
include proper lockout/tagout procedures for maintenance and programming operations.

It is the responsibility of the operating company to ensure that:

« All operators, maintenance technicians, programmers and other personnel are tested and qualified
before acquiring access to the machine or system.

« The above personnel perform their assigned functions in a responsible and safe manner to comply
with the procedures in the supplied documentation and the company safety practices.

« The equipment is maintained as described in the documentation and training supplied by the
machine/system designer.

Additional Equipment and Considerations

The Risk Assessment and the operating company's standard safety policies will dictate the need for
additional equipment. In general, it is the responsibility of the operating company to ensure that:

« Unauthorized access to the machine is prevented at all times.

» The personnel are supplied with the proper equipment for the environment and their job functions,
which may include: safety glasses, hearing protection, safety footwear, smocks or aprons, gloves,
hard hats and other protective gear.

» The work area is equipped with proper safety equipment such as first aid equipment, fire
suppression equipment, emergency eye wash and full-body wash stations, etc.

» There are no modifications made to the machine or system without proper engineering evaluation for
design, safety, reliability, etc., and a Risk Assessment.
Safety Information Resources

Additional SmartMotor safety information can be found on the Moog Animatics website; open the topic
"Controls - Notes and Cautions" located at:

https://www.animatics.com/support/downloads/knowledgebase/controls---notes-and-cautions.html

OSHA standards information can be found at:

https://www.osha.gov/law-regs.html

ANSI-RIA robotic safety information can be found at:

http://www.robotics.org/robotic-content.cfm/Robotics/Safety-Compliance/id/23

UL standards information can be found at:

http://ulstandards.ul.com/standards-catalog/
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Safety Information Resources

ISO standards information can be found at:

http://www.iso.org/iso/home/standards.htm

EU standards information can be found at:

http://ec.europa.eu/growth/single-market/european-standards/harmonised-standards/index_en.htm
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Additional Documents

Additional Documents

The Moog Animatics website contains additional documents that are related to the information in this
manual. Please refer to these lists.

Related Guides
« Moog Animatics SmartMotor™ Installation and Startup Guides

http://www.animatics.com/install-guides

» Class 6 D-Style SmartMotor™ Installation and Startup Guide

http://www.animatics.com/cl-6-d-style-install-startup-guide

o SmartMotor™ Developer's Guide

http://www.animatics.com/smartmotor-developers-guide

o SmartMotor™ Homing Procedures and Methods Application Note

http://www.animatics.com/homing-application-note

o SmartMotor™ System Best Practices Application Note

http://www.animatics.com/system-best-practices-application-note

In addition to the documents listed above, guides for fieldbus protocols and more can be found on the
website: https://www.animatics.com/support/downloads.manuals.html

Other Documents
¢ SmartMotor™ Certifications

https://www.animatics.com/certifications.html

o SmartMotor Developer's Worksheet

(interactive tools to assist developer: Scale Factor Calculator, Status Words, CAN Port Status, Serial

Port Status, RMODE Decoder and Syntax Error Codes)

https://www.animatics.com/support/downloads.knowledgebase.html

» Moog Animatics Product Catalog

http://www.animatics.com/support/moog-animatics-catalog.html

Additional Resources

The Moog Animatics website contains useful resources such as product information, documentation,
product support and more. Please refer to these addresses:
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Additional Resources

General company information:

http://www.animatics.com

Product information:

http://www.animatics.com/products.html

Product support (Downloads, How-to Videos, Forums and more):

http://www.animatics.com/support.html

Contact information, distributor locator tool, inquiries:

https://www.animatics.com/contact-us.html

Applications (Application Notes and Case Studies):

http://www.animatics.com/applications.html
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SmartMotor Overview

SmartMotor Overview

This chapter provides an overview of the design philosophy and functionality of the Moog Animatics
SmartMotor. It also provides information on SmartMotor features and options, and where to find related
documents and additional resources.

SmartMotor INtrOdUCHION ... .

LTR-Style SmartMotor Featuresand Options ...

LTR-17 SmMartMoOtor FeatUres ... .
LTR-23 SmartMotor FeatUres ... ..
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SmartMotor Introduction

SmartMotor Introduction

The Moog Animatics SmartMotor™ servo is an industrial servo motor with motion controller integrated into a
compact package. Its design is based on these objectives:

1. Reduce development time
2. Lower machine-production cost

3. Simplify the machine (design, build and support)

Class 5 LTR-17 and LTR-23 SmartMotor

The SmartMotor is powerful and unique because of its ability to control an entire machine. The combination
of programmability, networking, 1/0 and servo performance is unmatched. The SmartMotor brings savings
and value to the machine builder by removing complex and costly elements in the machine design, such as
PLCs, sensors, I/0O blocks, cabinets, etc.

LTR-Style SmartMotor Features and Options

NOTE: The LTR-Style SmartMotor™ is intended for RoHS-exempt applications only — the LTR motors
contain lead-based solder on some internal components to achieve increased reliability over greater
thermal ranges.

NOTE: All specifications are subject to change without notice. Consult the factory for the latest
information.

The following sections describe the features and options available on the LTR-style SmartMotors.

A note about SmartMotor part numbers:
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LTR-17 SmartMotor Features

The SmartMotor uses a coded part number, which contains characters that describe the motor number,
frame style and options. For details on decoding the SmartMotor part number, refer to the Understanding
SmartMotor Part Numbers document at this address:

https://www.animatics.com/support/downloads.knowledgebase.html

LTR-17 SmartMotor Features
NOTE: The LTR-17 SmartMotor requires firmware version 5.26.3.10 or later.

The SmartMotor is available in a Low Temperature Range (LTR), NEMA 17 configuration, which is called
the LTR-17 SmartMotor. All LTR-17 motors have these features:

» |IP62 rated, high-altitude operation

« Temperature information:
o Maximum internal temperature: 85°C at electronics, 130°C at windings
o Operating temperature range: -55°C to 70°C

NOTE: The internal circuit must be at -40°C or higher to establish communication. For
details, see Heater Power Requirements on page 26.

e Storage temperature range: -65°C to 85°C
« Low-temp startup with onboard heater to raise circuit temperature from -65°C to -40°C
» Ports: One 13-pin connector that handles all power and 1/0

NOTE: Only one LTR-style motor can be attached to a serial port. The LTR-style motors do not
support daisy-chain installation (multiple motors on the same network).

« LEDs: Two bi-colored LED indicators to show error codes, status and communications activity
« Magnetic, single-turn absolute encoder
e Four 5V TTL sourcing inputs

o Push-on/ pull-off, IP67-rated connector

CAUTION: connectors must be finger tightened only! DO NOT use a wrench
or other tool. Doing so can cause overtightening of the connection, which may

damage the connector and will void the warranty.

o RS-422 differential communication

NOTE: The LTR-Style SmartMotor™ is intended for RoHS-exempt applications only — the LTR motors
contain lead-based solder on some internal components to achieve increased reliability over greater
thermal ranges.
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LTR-23 SmartMotor Features

The next figure shows the connector and LED locations for the LTR-17 SmartMotor. For details on the
motor connectors, see Connecting the System on page 28. For details on the LED functions, see
Understanding the Status LEDs on page 34.

servo-Amp LED 13-Pin, IP67 Connector

Trajectory LED

LTR-17 SmartMotor Connector and LEDs

LTR-23 SmartMotor Features
NOTE: The LTR-23 SmartMotor requires firmware version 5.26.3.10 or later.

The SmartMotor is available in a Low Temperature Range (LTR), NEMA 23 configuration, which is called
the LTR-23 SmartMotor. All LTR-23 motors have these features:

» |P65 rated, high-altitude operation

NOTE: After a five-minute warmup, IP67 is possible with a flurosilicone O-ring installed between
the motor flange and an IP67-rated mating component (contact the factory for more details).

o Temperature information:
o Maximum internal temperature: 85°C at electronics, 130°C at windings
» Operating temperature range: -55°C to 70°C

NOTE: The internal circuit must be at -40°C or higher to establish communication. For
details, see Heater Power Requirements on page 26.

» Storage temperature range: -65°C to 85°C

» Low-temp startup with onboard heater to raise circuit temperature from -65°C to -40°C
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LTR-23 SmartMotor Features

Ports: One 8-pin connector that handles all power and communications; one 5-pin connector that
handles I/0O.

NOTE: Only one LTR-style motor can be attached to a serial port. The LTR-style motors do not
support daisy-chain installation (multiple motors on the same network).

LEDs: Two bi-colored LED indicators to show error codes, status and communications activity
Magnetic, single-turn absolute encoder
Three 5V TTL sourcing inputs

M-style connectors

CAUTION: connectors must be finger tightened only! DO NOT use a wrench
or other tool. Doing so can cause overtightening of the connection, which may

damage the connector and will void the warranty.

RS-422 differential communication

NOTE: The LTR-Style SmartMotor™ is intended for RoHS-exempt applications only — the LTR motors
contain lead-based solder on some internal components to achieve increased reliability over greater
thermal ranges.

The next figure shows the connector and LED locations for the LTR-23 SmartMotor. For details on the
motor connectors, see Connecting the System on page 28. For details on the LED functions, see
Understanding the Status LEDs on page 34.

8-Pin Com/Power Reserved LEDs 5-Pin I/0

Connector Connector

Trajectory LED Servo - Amp LED

L TR-23 SmartMotor Connector and LEDs
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SmartMotor Theory of Operation

SmartMotor Theory of Operation

The Moog Animatics SmartMotor is an entire servo control system built inside of a servo motor. It includes a
controller, an amplifier and an encoder. All that is required for it to operate is power and either an internal
program or serial commands from outside (or both). To make the SmartMotor move, the program or serial
host must set a mode of operation, state a target position with/or a maximum velocity at which to travel to
that target, and a maximum acceleration. After these three parameters are set, a "Go" command starts the
motion profile.

The core functional areas of the SmartMotor are:
» Motion Control Functions (see Motion Details in the SmartMotor™ Developer's Guide)

» System Control Functions (see Program Flow Details and see System Status in the SmartMotor™
Developer's Guide)

o Communication Functions (see Communication Details in the SmartMotor™ Developer's Guide)

e 1/O Functions (see I/O Control in the SmartMotor™ Developer's Guide)
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SmartMotor Theory of Operation

The next block diagram illustrates the relationship between the functional areas in the SmartMotor.
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NOTES,

1. MAMUL and MFDIV commands do not have an effect on dwell time or distance. Dwell is strictly based on raw controllerl encoder counts selected by the
SRC() command specifying internal virtual controller count source.

2. When feeding a Cam table with a gearing profile, changesto MFMUL and MFDIV will affect the time it takes to move through a Cam table but will not
affect dwell time, as specified in the previous note.

SmartMotor Theory of Operation Diagram

1Moog Animatics has replaced the terms "master" and "slave" with "controller" and "follower", respectively.
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Getting Started

Getting Started

This chapter provides information on getting started with your SmartMotor.

Unpacking and Verifying Your Shipment ... ... 21
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Making the Motor MOVe .. 43
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Getting Started

Viewing the Motor Position with the Motor View Tool ...,
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Unpacking and Verifying Your Shipment

Unpacking and Verifying Your Shipment

Your Moog Animatics SmartMotor and accessories are carefully assembled, tested, inspected and packed
at the factory.

When you receive your shipment, you should:

» Visually inspect all shipping containers for visible signs of shipping damage. If you see damage,
please notify your carrier and then contact Moog Animatics to report the problem.

» Carefully unpack each component and verify the part number with your order. If there are any
differences or missing items, please contact Moog Animatics so that the shipment can be corrected.

» Keep all boxes and packing materials. These may be needed for future storage or shipment of the
equipment.

Installing the SMI Software

The SmartMotor Interface software (SMI software) provides a convenient user interface for programming
the SmartMotor. Before you can use the SMI software, it must be installed on a Microsoft Windows PC.

The SMI software is distributed on CD-ROM or USB stick, and is also available as a download from the
Moog Animatics website. To download the latest version of the SMI software, use this address:

http://www.animatics.com/smi

Then scroll to the bottom of the page and click the Free Download button.

FREE DOWNLOAD

SMI Download Button

The installation package is downloaded to your system.

NOTE: The SMI software requires Microsoft Windows XP or later.

Installation Procedure

NOTE: Depending on the SMI software version and SmartMotor model being used, the software
version and motor information may be different on your screens.

To install the SMI software:
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Installation Procedure

1. Double-click the executable package (.MSlI) file to begin the installation. In some versions of
Microsoft Windows, you may receive a security warning message about running the file. You can
ignore this message.

If this is a new installation, go to the next step.

If this is an upgrade to a previous installation, you will see the window below. Select Remove, click
Next and remove the existing software from your PC using the instructions.

ﬁ SmartMotor Interface Setup

Application Maintenance
Select the maintenance operation to perform,

Version 3.0.0.70 (with IntegMotorinterface 2.2.3.17)

() Modify
=g Change which applization features are installed. Dizplays the
@g Select Featurez dialog, which lets you configure individual features.
=
) Repair
Reinztall missing or cormupt files, registry keys, and shortouts,
@T Preferences stored in the registiy may be reset to default values.
i=
® Remove
; |Irinztall Smartkdator Interface from thiz computer.
-‘
E D‘i

Wize Inztallation Wizard [R]

< Back Cancel

After removing the existing software, restart the installation process.
NOTE: All personal settings and user files will be retained.

2. Click Next to proceed. The Installation Configuration page opens.

15 SmartMotor Interface Setup — it

Installation Configuration

Set property values used for configuring the installed application.

Version 3.0.0.70 (with IntegMotorinterface 2.2.3.17)

Select desired language: E malizh ol

Wise Installation Wizard®
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Installation Procedure

3. Click Next to proceed. The SMI software installation wizard starts and the Welcome page opens.

jﬁl SmartMotor Interface Setup - d

Welcome to the SmartMotor
Interface Installation Wizard

It iz strongly recommended that you exit all Windows programs
before rinning thiz zetup program.

Click Cancel to guit the setup program, then close any programs
wou have running. Click Mest to continue the inztallation.

WARMIMG: Thig program iz protected by copyright law and
international treaties.

|Inauthaorized reproduction or diztribution of thiz program, or any

portion of it, may result in severe civil and criminal penalties, and
will be progecuted to the maximum extent poszible under law,

< Back Cancel

4. After you have finished reviewing the welcome information, click Next to proceed. Use the on-screen
instructions to complete the SMI software installation.
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Installation Verification

5. When the installation has completed, the installation status message page opens, as shown in the
next figure. Click Finish to complete the installation and close the installation wizard.

jﬁl SmartMotor Interface Setup - d

SmartMotor Interface has been
successfully installed.

Click. the Finish buttan to exit thiz inztallation.

< Back Cancel

NOTE: After the software is installed, be sure to restart your computer before running the SMI software.

Installation Verification

To verify the installation, navigate to the C:\Program Files (or folder C:\Program Files x86) folder. You
should see these folders:

4 Animatics

SMIE

Accessing the SMI Software Interface

The SmartMotor Interface software (SMI software) communicates with a single or series of SmartMotors
from a Windows-based PC and gives you the capability to control and monitor the status of the motors. The
SMI software also allows you to write programs and download them into the SmartMotor’s long-term
memory.

NOTE: Every SmartMotor has an ASClI interpreter built in. Therefore, it is not necessary to use the SMI
software to operate a SmartMotor.

To open the SMI software, double-click the SmartMotor Interface shortcut on the Windows desktop.

o
F1=
SmartMotor
Interface

SmartMotor Interface Shortcut
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Accessing the SMI Software Interface

Optionally, to open the SMI software from the Microsoft Windows Start menu, select:
Start > All Programs > Animatics > SMI3 > SmartMotor Interface

The SMI software interface opens, as shown in the next figure.

Bl SmartMotor Interface - [SMI1] S
Menu bar || File Edit View Communication Compile Teols Window Help
Toolbar — L= Hd EE b AT MY > m 0N T
[Lconfiguration _ |l Formina
| EE =
— Find Mators /r‘ Coml | Ethemet | USE | CAN Channel 0 | L r:ul I E=5E o)

anﬁguratlon [=-E] Detected Config I~ Open  [aMators
window [y 3600 bps) |

/ L CAN Channel 0 (125000 bps)
Terminal

window /

Program /

editor

_—|[Goma 3800 RS a8 R g~
__semd_|

Location Desciiption

Information
window

For Help, press F1 Version: 5.0.2 MNUM Lnl, Coll

SMI Software Interface

NOTE: In addition to the software information in this section, there is context-sensitive help available
within the SMI software interface, which is accessed by pressing the F1 key or selecting Help from the
SMI software main menu.

These are the primary features in this interface:

« Menu Bar: All of the windows and functions of the SMI software can be accessed through the menu
bar. Many of these are also accessible through the icons on the toolbar.

» Toolbar: The toolbar contains a collection of icons for accessing the primary features of the SMI
software. Depending on the current state of the SMI software and the currently-active window, some
toolbar buttons may be disabled.

« Configuration Window (far-left window): This window is used to display the current communication
and detected motor configuration when no project is open, or the communication and motor
configuration defined in an open project.

o Terminal Window (middle window): This window is used to communicate with SmartMotors (for
example, issue single-line commands to one or all motors). The response (if any) is also shown in
this window.

 Information Window (lower window): This window is used to display the results of user operations.

» Program Editor (far-right window): This window is used to manage, edit and print user programs.
Most of the procedures for using the editor should seem familiar if you have used other Windows-
based text editors.

For more details about these items, see the SMI software online help, which can be viewed in SMI by
pressing F1 or selecting Help > Contents - SMI Software Help.
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Understanding the Power Requirements

Understanding the Power Requirements

This section describes the power requirements for Class 5 LTR-style SmartMotor power, CPU power, 1/0
power and Communications power.

Motor Power Requirements

Requirement:

For LTR-style SmartMotors: motor power requires nominal 48 VDC and is operational from 40 to 50 VDC.
Do not exceed 50 VDC.

NOTE: Itis recommended that motor power and heater power have dedicated (separate) power
supplies.

CAUTION: Voltages outside of the stated range may damage the motor circuit or
impair its performance.

Control (CPU) power is internally supplied off the main motor power. Unlike other SmartMotors, there are
no separate control power input pins.

Details: These SmartMotors can draw high current. At least 14 AWG wire is recommended for powering
the SmartMotor.

Voltages below 40 VDC could cause a brownout shutdown of the CPU, or what would appear as a power-
off reset, under sudden load changes.

CAUTION: If power is reversed on any standard SmartMotors, immediate damage
WILL occur and the SmartMotor will no longer operate.

When relying on torque/speed curves, pay close attention to the voltage on which they are based.

During hard, fast decelerations, a SmartMotor can pull up supply voltages to the point of damage if a shunt
resistor pack is not used. Protective shunts are available from Moog Animatics.

Special care must be taken when near the upper voltage limit or in vertical applications that can back-drive
the SmartMotor. Gravity-influenced applications can turn the SmartMotor into a generator and back-drive
the power supply voltage above the safe limit for the SmartMotor. Many vertical applications require a shunt
to protect the SmartMotor from damage. Protective shunts are available from Moog Animatics.

CAUTION: Many vertical applications and applications with hard, fast decelerations

require shunts to protect the SmartMotor from damage. Note that shunts should
always be placed between the motor input and any disconnect or E-stop relay to
protect the motor when power is off or E-stop relay contacts are open.

Heater Power Requirements

On LTR-style SmartMotors, built-in heaters can be used to raise the CPU board temperature when it drops
below -40 degrees C. This allows the SmartMotor to start up in extremely cold environments. After the
motor is running, the heaters are not required. The heaters will warm only the circuit board and will not
warm any mechanical parts, such as the bearings or shaft.
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Heater Power Requirements

Requirement:

For LTR-style SmartMotors: heater power requires nominal 48 VDC and is operational from 40 to 50 VDC.
Do not exceed 50 VDC.

NOTE: It is recommended that motor power and heater power have dedicated (separate) power
supplies.

CAUTION: Voltages outside of the stated range may damage the heater circuit or
impair its performance.

The heater power is externally supplied and controlled by the user. It should only be operated between -65
degrees C and 0 degrees C, the target temperature for activating the heater is -40 degrees C or below. The
length of time to operate the heater is proportional to how long the motor has been powered off in a -40
degrees C (or below) environment. The test of proper board temperature is to try to communicate with the
motor—if you can, then the board has reached operating temperature.

CAUTION: ltis the user's responsibility to externally control the heater, and warm the
board to -40 degrees C or higher to establish communication with the SmartMotor.
Only operate the heater between -65 degrees C and 0 degrees C; ensure the heater is

off at 0 degrees C. Application of the heater above 0 degrees C can damage the
motor.

Follow this procedure:

1. Measure the ambient air temperature in the vicinity of the motor. If the ambient temperature is at or
below -40 degrees C then the heater can be activated as follows:

« If the motor has been powered off and at or below -40 degrees C for two or more hours, the
heater should be operated for approximately 5 minutes. This will raise the internal circuit
board to operating temperature.

« If the motor has been powered off and at or below -40 degrees C for less than two hours, the
heater should be operated for less than five minutes, gauging the time proportionally, based
on how long the motor has been powered off and at or below -40 degrees C.

2. Power on the motor and attempt to establish communications.

« If you are able to establish communications with the motor, the internal circuit is warm
enough. Proceed to the next step.

« If you are unable to establish communications with the motor, the internal circuit requires
additional heating—continue heating in 30 second intervals and retest until you can establish
communications. Proceed to the next step.

3. After communications are established, use the TEMP command to monitor the internal circuit board
temperature. For details, see the SmartMotor™ Developer's Guide.

4. Deactivate the heater before the board temperature reaches 0 degrees C.

CAUTION: Never operate the heater when the board temperature is at 0 degrees C
or higher, as this can damage the motor.
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CPU, I/0 and Communications Power

CPU, I/0 and Communications Power

This section describes the requirements for CPU, I/O and Communications power. For information on how
the SmartMotors handle voltage spikes on the I/O line, see I/O Voltage Spikes in the SmartMotor™
Developer's Guide.

CPU Power Requirements

Requirement: The CPU is powered from the "motor" power input.

Details: The CPU is powered from the "motor" power input (pin 1 on the LTR-17 motor 13-pin connector;
pin 7 on the LTR-23 motor 8-pin connector). The supply must be from 40 to 50 VDC, as this input cannot
handle a higher voltage. To achieve optimum motor torque, use nominal 48 VDC.

I/0 Power Requirements

Requirement: The I/O is powered from the "motor" power input.

There are three input ports. Each of these inputs is 5 VDC max. These three ports can be configured as
analog to digital converter (ADC) and can handle an input from 0 to 5 VDC. The motor's ADC sample
resolution is 10 bits.

Details: The 1/O is powered from the "motor" power input (pin 1 on the LTR-17 motor 13-pin connector; pin
7 on the LTR-23 motor 8-pin connector). The supply must be from 40 to 50 VDC, as this input cannot
handle a higher voltage. To achieve optimum motor torque, use nominal 48 VDC.

NOTE: This I/O is not isolated from the CPU's power supply and the motor drive.
Communications Power Requirements

Requirement: The RS-422 signal is powered from the "motor" power input.

Details: The RS-422 signal is powered from the "motor" power input (pin 1 on the LTR-17 motor 13-pin
connector; pin 7 on the LTR-23 motor 8-pin connector). The supply must be from 40 to 50 VDC, as this
input cannot handle a higher voltage. To achieve optimum motor torque, use nominal 48 VDC.

NOTE: The RS-422 signal is not isolated from the CPU's power supply or the motor drive.

Connecting the System

These sections show system connections and cable diagrams for typical installations.
NOTE: Only one LTR-style motor can be attached to a serial port. The LTR-style motors do not support
daisy-chain installation (multiple motors on the same network).

Minimum Requirements

At minimum, you will need these items:

An LTR-17 or LTR-23 SmartMotor

A computer running Microsoft Windows and the SMI software

w =

Power and data cables for the SmartMotor
4. Power supplies (for power requirements, see Understanding the Power Requirements on page 26)

NOTE: Itis recommended that motor power and heater power have dedicated (separate) power
supplies.
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LTR-17 Motor Connectors and Pinouts

LTR-17 Motor Connectors and Pinouts
The next figure provides an overview of the connectors and pinouts available on the LTR-17 SmartMotors.

13-pin, IP-67 Receptacle 2 8 1
(Glenair PN 804-005-07M8-13PA)

4 115

+48V Motor Power In

Motor Power Return (Common)
RS-422 Rx-

Heater Power Return (Optional)
+48V Heater Power In (Optional)
General Purpose 1/0 2

General Purpose 1/0 1

General Purpose 1/0 0

RS-422 Rx+

RS-422 Tx+

Logic Ground (Common)
General Purpose 1/0 3

RS-422 Tx-

O |IN[OalhlOWIN|=

©

-
o

N
-

-
N

(

.
=
w

CAUTION: connectors must be finger tightened only! DO NOT use a wrench or other
tool. Doing so can cause overtightening of the connection, which may damage the

connector and will void the warranty.

The next table provides information on the mating connector for the 13-pin SmartMotor receptacle.

Glenair PN Description
804-002-06M8-13S E(Iel;g with Accessory Thread, Size 8-13, #23 Sockets. Single
809-002 #23 Socket, Wire #22 - #28, Material: BeCu, Tool Code: A, C
620MS065M08 Strain Relief Clamp for Series 80 Size 8

The next table provides the tool information for building the mating connector.

. . . Tool
Glenair PN Description Code
809-088 Insertion/Extraction Tool
809-015 Adjustable Crimp Tools A
Positioner for standard size #23 contacts. #22-#28
809-005 AWG. Use with 809-015 crimp tool. C

These items in the previous tables are available from Glenair, Inc. For further information, see their website
at: http://www.glenair.com.
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LTR-17 Power, Heater and RS-422 Com Cable Diagram

LTR-17 Power, Heater and RS-422 Com Cable Diagram

RS-232 to RS-422
Adapter

' Com 1/0
.. I ==X

Sa

48V Drive Power —3» !7

Separate 48V =3 Motor &

Heater Power Heater
Power

CAUTION: connectors must be finger tightened only! DO NOT use a wrench or other
tool. Doing so can cause overtightening of the connection, which may damage the
connector and will void the warranty.

NOTE: It is recommended that motor power and heater power have dedicated (separate) power
supplies.

board to -40 degrees C or higher to establish communication with the SmartMotor.
Only operate the heater between -65 degrees C and 0 degrees C; ensure the heater is

off at 0 degrees C. Application of the heater above 0 degrees C can damage the
motor.

ﬁ CAUTION: ltis the user's responsibility to externally control the heater, and warm the
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LTR-23 Motor Connectors and Pinouts

LTR-23 Motor Connectors and Pinouts

The next figure provides an overview of the connectors and pinouts available on the LTR-23 SmartMotors.

8-Pin Com and
Power Connector 5-Pin 1/0 Connector

POWER RETURN INPUT 2

HEATER RETURN INPUT 0
HEATER +48V GROUND
RX+ INPUT 1
TX- NC

RX-
POWER IN +48V
TX+

O IN|[OO | |WIN|=

TRAJECTORY - - SERVO-AMPLIFIER
LED LED

CAUTION: connectors must be finger tightened only! DO NOT use a wrench or other
tool. Doing so can cause overtightening of the connection, which may damage the

connector and will void the warranty.

Moog Animatics supplies flying-lead cables with connectors at the mating end, which can be purchased for
use with the LTR-23 SmartMotors. Refer to the next table.

Moog Animatics PN Description
CBLIP-CAN-FL CAN Flying Lead Cable (5-Pin Connector)

CBLIP-COM-FL COM Flying Lead Cable (8-Pin Connector)
NOTE: These are available with an optional right-angle connector at one end.

The next tables show the pins, wire colors and descriptions for the mating flying-lead cables described in
the previous table.

CBLIP-CAN-FL, 5-Pin Connector
C\;Y)i Ir:r Description Pin
Bare Input 2 (5 VDC) 1
Red Input 0 (5 VDC) 2
Black Ground (common) 3
White Input 1 (5 VDC) 4
Blue No connection 5
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LTR-23 Power, Heater and RS-422 Com Cable Diagram

CBLIP-COM-FL, 8-Pin Connector
(\?g Ir;_ Description Pin
White - Blue Ground (common) 1
White - Brown Heater return 2
Brown Heater supply (48V) 3
Orange RX+ 4
White - Green TX- 5
White - Orange RX- 6
Blue Motor supply (48V) 7
Green TX+ 8

LTR-23 Power, Heater and RS-422 Com Cable Diagram

RS-232 to RS-422
Adapter

1
II I ;Com

°) CBLIP-CAN-FL

CBLIP-COM-FL

/10

48V Drive Power =—3»

Separate 48V =3 Motor &
Heater Power Heater
Power

CAUTION: connectors must be finger tightened only! DO NOT use a wrench or other
tool. Doing so can cause overtightening of the connection, which may damage the

connector and will void the warranty.

NOTE: It is recommended that motor power and heater power have dedicated (separate) power
supplies.

CAUTION: ltis the user's responsibility to externally control the heater, and warm the
board to -40 degrees C or higher to establish communication with the SmartMotor.
Only operate the heater between -65 degrees C and 0 degrees C; ensure the heater is

off at 0 degrees C. Application of the heater above 0 degrees C can damage the
motor.
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Maximum Cable Length

Maximum Cable Length

For transmission speeds of 200 kilobits/second, RS-422 communications can support shielded cable
lengths up to 200 meters. Note that signal rate degrades as the cable length increases.
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Understanding the Status LEDs

Understanding the Status LEDs

This section describes the functionality of the Trajectory and Servo-Amp status LEDs on the LTR-17 and
LTR-23 SmartMotors.

8-Pin Com/Power Reserved 5 piy /g

S -A LED Cc L ( C
ervo P 13-P P-67C nnector onnecto
Se VO A p LED

Trajectory LED Trajectory LED

LTR-17 SmartMotor LTR-23 SmartMotor

(back & front views) (back view)
‘e ™\ e I\
LED 0: Servo - Amp LED “ | LED 1: Trajectory LED |
Off No power Off Not busy
Solid green Drive on Solid green Drive on, trajectory in progress
Flashing green  Drive off
Flashing red Watchdog fault
Solid red Major fault
Alt.red/green  Inboot load; needs firmware
AN //’ N //‘
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Detecting and Communicating with the SmartMotors

Detecting and Communicating with the SmartMotors
NOTE: The LTR-17 and LTR-23 SmartMotors require firmware version 5.26.3.10 or later.

NOTE: Only one LTR-style motor can be attached to a serial port. The LTR-style motors do not support
daisy-chain installation (multiple motors on the same network).

This section describes how to detect and address the LTR-style SmartMotors over the serial network.
This procedure assumes that:
» The SmartMotor is connected to the computer. For details, see Connecting the System on page 28.

« The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 26 and Connecting the System on page 28.

« The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 21.

Understanding the Detection and Configuration Options

There are several ways to use the SMI software to find and address the LTR-style SmartMotors that are
connected to your PC:

NOTE: This feature requires connection to the serial port using an RS-422 adapter. The serial port must
be configured as RS-232 in SMI.

» Use the Find Motors button—this method is recommended for first-time communications or when you
don't know the port used to connect the motors. For details, see Using the Find Motors Button on
page 35.

« Use the Detect Motors feature—this method can be used if you know the communications port used
to connect your motors and if your motors may be pre-addressed. For details, see Using the Detect
Motors Feature on page 38.

» Use the Address Motors feature—this method can be used if you know the communications port used
to connect your motors. This method always re-addresses the motors; therefore, if you have pre-
addressed motors connected, their addresses may be changed. For details, see Detecting and
Communicating with the SmartMotors on page 35.

Several of these methods are described in the next sections.

Using the Find Motors Button

NOTE: Only one LTR-style motor can be attached to a serial port. The LTR-style motors do not support
daisy-chain installation (multiple motors on the same network).

The easiest way to locate any connected SmartMotor is to use the Find Motors button (see the next figure).
This method searches the RS-232 port(s) on the PC for connected motors.

To begin searching for motors on the RS-232 port(s) on the PC, in the Configuration window of the SMI
software interface, click Find Motors. The SMI software begins searching for all SmartMotors connected to
the PC.
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Using the Find Motors Button
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Find Motors Detecting SmartMotors on the RS-232 Bus

After the motors are detected, the SMI software will address them if needed. The next steps are only used
when the SMI software finds motors that do not have addresses.

To address the motors, click Yes when you see the following prompt.

Shdl iz about to fry and address the motors, This will izsue an EMD command cawsing
I . the running program to stop exscution. Do you wizh SMI to contirue?

MHa I

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software addresses the
motors. During this process, the SMI software is collecting the following information on each motor. The
information is the same as that shown in the Motor View window, which can be accessed by selecting the
Tools > Motor View > Info tab:
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Using the Find Motors Button

i | Motor View - "Motorl-Com1”

Status  Info

|M0nit0r| User\fariablesl Flags | Calculationsl Trace |

Motor Name
hatar Address
“argion

Serial Number
Model

Sample FPeriod
Frogram Marme
Daownload Time
Frogram Size
Ship Date

Firrnware Date

: IMGtDr1-CDm1

:|1

: |5.25.3_1n

:|E13U499

: |SM1 72050-LTR

: |n.125mu

: |SMI1.smx

: |D4,."22,."201E 14:36:31

: |56

: |D3,.’22,.’2018

: IMarEE 2018 13:08:28
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(m{dsy himis)
Bytes

Scaling:
’7 Mo scale is defined for this motor. To define scale, click the "Edit Properties"
buttan.

Display ADB

Save ADB

Details

Edit Properties

Get Info

Motor View Information

Find Mators

After the process has completed, the SMI software shows the found motors in the Configuration window
under the corresponding communications port. Each motor is represented by a motor icon; the motor's
address and firmware version are shown next to the motor icon.

Detected Confiquration

Com1 [R5232-3600 bps)

%8 Motorl-Coml [5.26.3.10)

Ethemet
sE

CAM Channel O [125000 bps)

Configuration Window Showing Found/Addressed SmartMotor
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Using the Detect Motors Feature

Using the Detect Motors Feature

NOTE: Only one LTR-style motor can be attached to a serial port. The LTR-style motors do not support
daisy-chain installation (multiple motors on the same network).

This method is similar to the Find Motors method, but it searches only the specified communications port
for connected SmartMotors. This is also the recommended method for detecting the motors after they have
been pre-addressed and connected to the communications port.

To use the Detect Motors feature, in the Configuration window of the SMI software, right-click the desired
communications port and select Detect Motors from the menu.

| Find b ators |

ElE [I_I__ete-::ted Configuration

S 8 Com | [
nb" Port Properties

Detect (and Address) Motors on R5-232
Set Baud Rate

Selecting the Detect Motors Feature

The SMI software begins searching for all SmartMotors connected to the specified communications port. A
progress bar is shown while the SMI software searches for the motors.

After the motors are detected, the SMI software will address them if needed. The next steps are only used
when the SMI software finds motors that do not have addresses.

To address the motors, click Yes when you see the following prompt.

Shdl iz abouk fo fry and address the motors, This will izswe an EMD command cawsing
the rurning program to stop executicn, Do you wizh SMI to contirue?

Mo |

Address the Motors Prompt

A progress bar displays a "Getting motor information" message while the SMI software addresses the
motors. During this process, the SMI software is collecting the following information on each motor. The
information is the same as that shown in the Motor View window, which can be accessed by selecting the
Tools > Motor View > Info tab:
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Using the Detect Motors Feature

i | Motor View - "Motorl-Com1”

Status  Info

|M0nit0r| User\fariablesl Flags | Calculationsl Trace |

Motor Name
hatar Address
“argion

Serial Number
Model

Sample FPeriod
Frogram Marme
Daownload Time
Frogram Size
Ship Date

Firrnware Date

: IMGtDr1-CDm1

:|1

: |5.25.3_1n

:|E13U499

: |SM1 72050-LTR

: |n.125mu

: |SMI1.smx

: |D4,."22,."201E 14:36:31

: |56

: |D3,.’22,.’2018

: IMarEE 2018 13:08:28

mSec.

(m{dsy himis)
Bytes

Scaling:
’7 Mo scale is defined for this motor. To define scale, click the "Edit Properties"
buttan.

Display ADB

Save ADB

Details

Edit Properties

Get Info

Motor View Information

Find Mators

After the process has completed, the SMI software shows the found motors in the Configuration window
under the corresponding communications port. Each motor is represented by a motor icon; the motor's
address and firmware version are shown next to the motor icon.

Detected Confiquration

Com1 [R5232-3600 bps)

%8 Motorl-Coml [5.26.3.10)

Ethemet
sE

CAM Channel O [125000 bps)

Configuration Window Showing Found/Addressed SmartMotor
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Checking and Clearing the Status Bits

Checking and Clearing the Status Bits

NOTE: In addition to the software information in this section, there is context-sensitive help available
within the SMI software interface, which is accessed by pressing the F1 key or selecting Help from the
SMI software main menu.

The Motor View window is used to view and monitor various motor parameters. It is used in conjunction
with the Terminal window to clear any active overtravel limits.

This procedure assumes that:
» The SmartMotor is connected to the computer. For details, see Connecting the System on page 28.

« The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 26 and Connecting the System on page 28.

« The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 21.

e The SmartMotor has been detected and addressed.

Moog Animatics LTR-Style SmartMotor™ Installation and Startup Guide, Rev. F
Page 40 of 50



Polling the Motor

Polling the Motor
To view the current state of the status bits, you must poll the motor.
1. Double-click the motor icon to open the Motor View window (see the next figure).

2. Click the Poll button to begin polling data from the motor.

- -

B | Motor View - "Motorl-Com1" 2

Statuz 1 Info ] Mnnitnr] Lzer ‘v"arial:ules] Flagz ] Ealculatinns] Trace | Metwak |

o | s | Forc |GEOETED  Aoom

[ Scale [~ Hex Dizplay 1
Pasition: 497227 |Status Wwhord O LJ
Pos. Error: 1]
st (98948 03 Drive ready
b Welocity 1 (3 Bo: Motoris off

2 i Bt Trajectory in progress
None 3 33 Bus= voltage fault

Mone - 4 {3 Ba; Over-current occurred

§ i3 Bh: Excessive temperature fault
f 3 Be: Excessive position error
o1 2 3 7 (3 Bv: Velocity limit
L X N N 8 3 Realtime temperature limit

9 (3 deidt error limit
10 CF Positive HAW limit enabled
11 03 Negative HAW limit enabled
12 (3 Br: Historical positive HAW limit
13 03 Bl Historical negative HAW limit
14 03 Bp: Positive HAW limit asserted
15 03 Bm: Negative HAW limit asserted

Input/Output: — Red By, Grey Oy

Clear Flagz [£5]

Ver: 5.26.3.10 Model: SM17205M-LTR

Motor View

A SmartMotor with no program and no I/O connections will boot up with active overtravel limits (see the red
status bits numbered 10 through 15 in the previous figure). However, an LTR-style SmartMotor will boot up
with no travel limits (the default operation).

CAUTION: An LTR-style SmartMotor will boot up with no travel limits (the default
operation).
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Clearing the Fault Bits

Clearing the Fault Bits

To clear the historical fault bits, enter ZS. All remaining fault bits are cleared, as shown in the next figures.

Terminal

Carn |
| Ethermet | USE | CAM Charnel 0 ] S —
W Open  |alMotors o+ ||Coml 9600 RS232 Chi0,8N1 11 G Negative HIW iimit enabled

| S and | 12 3 Br: Historical positive HAW limit
13 3 Bl Historical negative HAW fimit
14 3 Bp: Positive HAW limit az=erted

15 (3 Bm: Megative HOW limit aszerted
ZS Command Entered Remaining Bits Cleared
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Moving the SmartMotor

Moving the SmartMotor

NOTE: In addition to the software information in this section, there is context-sensitive help available
within the SMI software interface, which is accessed by pressing the F1 key or selecting Help from the
SMI software main menu.

The SMI software contains a Torque mode that is used to test the motor response and ensure the drive is
operating properly.

This procedure assumes that:
» The SmartMotor is connected to the computer. For details, see Connecting the System on page 28.

« The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 26 and Connecting the System on page 28.

« The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 21.

« The SmartMotor has been detected and addressed. For details, see Detecting and Communicating
with the SmartMotors on page 35.

« The fault bits have been cleared. For details, see Checking and Clearing the Status Bits on page 40.

Making the Motor Move

WARNING: The larger SmartMotors can shake, move quickly and exert great force.
Therefore, proper motor restraints must be used, and safety precautions must be

considered in the workcell design (see Other Safety Considerations on page 6).

To make the SmartMotor move:

1. Inthe Terminal window, select the tab that matches the communications channel to which your
motors are connected. To do this, look at the Configuration window, find the channel where the
motors are listed and click that tab name in the Terminal window.

Find tataors

- LAl
a ' Com [RS5232-9600 bps]

@ o ol TR e L SR

----- 7 Ethemet
o USE
L CAMN Channel 0 [126000 bpz]

Tab Selected that Matches the Communications Channel

[v Open |allt

NOTE: If you do not have the correct tab selected, the commands you enter will not go to the
motors and there will be no response.
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Setting and Reporting Torque

2. Enter these commands in the Terminal window:
Coml | Ethemet | USE | CAN Channel 0]
v Open |ﬁi‘«IIMn:uh:|rs j|I:-:|m'|,HEDD,HSEEE,Eh:D,Em

| Send

You should immediately see the motor shaft moving in the positive direction (clockwise, when
looking at the end of the motor shaft). If the motor does not respond to the commands, see
Troubleshooting on page 48 for troubleshooting tips.

NOTE: Macros (shortcut keys) can be used to simplify entry of frequently-used commands. For
details, see Macros in the SmartMotor™ Developer's Guide.

3. After you have observed the motor shaft turning, enter the X command to decelerate the motor to a
stop.

Setting and Reporting Torque

The commands in this section are related to the previous motion procedure. For more details on these
commands, see the SmartMotor™ Developer's Guide.

MT (Mode Torque)

MT sets the mode of operation to torque mode. In this mode, the SmartMotor shaft applies a torque
independent of position. For more details, see Torque Mode in the SmartMotor™ Developer's Guide.

T=formula (Set Target Torque)

T can be set to any value from -32767 to +32767, which represents -99.99% to +99.99% PWM (pulse-width
modulation) commanded.

RTRQ (Report Actual Torque)
Enter RTRQ at the Terminal window to report the commanded torque from the trajectory generator.

Note that RTRQ typically reports a value that's one less than the T value. In the previous example, T=3000,
but RTRQ reports 2999. The value returned by TRQ (and RTRQ) will typically be one less than the T
(torque) value due to internal calculations. It may also be reduced in cases where the motor’s output is in
limitation. TRQ represents the output effort of the motor in both MT (torque mode) and servo modes (MV,
MP, etc.). Therefore, it provides a seamless transfer across those modes without causing a ripple or bump
in force to the load.

TS (Set Torque Slope)

The TS command defines how fast the processor applies a change in torque. For an example of the
TS command, see the Chart View Example in the SmartMotor™ Developer's Guide.

Torque slope can range from -1 to 2147483647 (default). At a value of 65536, the processor changes
torque by a value of 1 for each PID sample. The default sample rate is; you can view the current sample
rate with the RSAMP command.
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Checking the Motor Position

Checking the Motor Position

There are several ways to check the motor position:
» Report the position using commands from the Terminal window
« View the position in the Motor View tool

These two methods are described in the next sections. You can also view the position in the Monitor or
Chart View software tools. For details, see SMI Software Features in the SmartMotor™ Developer's Guide.

This procedure assumes that:
« The SmartMotor is connected to the computer. For details, see Connecting the System on page 28.

» The SmartMotor is connected to a power source. For details, see Understanding the Power
Requirements on page 26 and Connecting the System on page 28.

» The SMI software has been installed and is running on the computer. For details, see Installing the
SMI Software on page 21.

« The SmartMotor has been detected and addressed. For details, see Detecting and Communicating
with the SmartMotors on page 35.

» The fault bits have been cleared. For details, see Checking and Clearing the Status Bits on page 40.

Viewing the Motor Position with a Report Command

To report the motor position, in the Terminal window, issue the RPA (Report Position Actual) command:
RPA

The terminal responds with the current position of the motor:

RPA 3593657

NOTE: The position is reported on the same line as the command; there is no line feed or carriage
return for "report" commands.

The RPA command reports the actual motor position at the time the command was issued. Therefore, itis
just a "snapshot"—if the motor is moving, the reported position is not dynamically updated.
Viewing the Motor Position with the Motor View Tool

The Motor View tool provides another way to view the motor position. The advantage of using this tool is
that the position is dynamically updated when the motor is moving.
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Viewing the Motor Position with the Motor View Tool

To open the Motor View tool, from the SMI software Configuration window, right-click the motor you want to
view and select Motor View from the menu.

Configuration
Find Motors | Com’ | Ethernetl SE
EIE Detected Configuration W Open IJ"—"-"MDthS
= Coml RS 232-9600 bps) |
% Etherr Motor View
- ; USBM Motor Properties
..... :‘5!*: CAM [I Set Motor Address
SmartMetor Playground

Opening the Motor View Tool

After the Motor View window opens, click the Poll button to begin polling (getting information from) the
motor. After polling begins, the motor position is shown in the Position box.

r

B | Motor View - "Motorl-Com1” | _EE _|

Status ]Info I Ml:nnih:nri ser Variablesl Flags i Ealculatiansl Trace | Metwork |

o | sw | oo |GUODTER  sooe
[T Scaled [~ Hex Display 1
Pasitior ;49?22? . Statuz Word 0 =
Pos. Emor; |a :
Velacily 93948 0@ Orive ready
Hlade Velooy 1 3 Bo: Motor is off

| | 2 (3 Bt: Trajectory in progress
|!N"'"'1B = 33 Bus voltage fautt
!INnne "i | 4 (J Ba; Over-current occurred

5 (J Bh: Excessive terparature fault

Input/Output — Red Sv. Grey v = | g 3 Be: Excessive position error
D71 2 §& 7 (3 Bv: Velocity limit
S8 90 8 (J Realtime temperature limit

9 (3 deidt error limit

10 G Positive HAW limit enabled

11 3 Negative HAW limit enabled

12 (3 Br: Historical positive HAW limit

13 C:J Bl. Histerical negative HAV limit

14 (3 Bp: Positive HAW limit asserted

16 (3 Bm: Negative HAV limit asserted

Clear Flags 25] |

Ver: §26.3.10 Model: SM17205M:LTR

Motor View Tool Showing the Motor Position
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Other LTR-Style Changes

Other LTR-Style Changes

In addition, please note these items:

Changes to Commutation Modes

The LTR-style motor uses a magnetic, single-turn absolute encoder. Because of this, the motor does not
have to wait for the internal encoder index mark when operating in MDS or MDC commutation modes. This
is different from the standard Class 5 SmartMotor. For details on the standard operation, see Commutation
Modes in the SmartMotor™ Developer's Guide..

Features Not Available
These Class 5 SmartMotor features have not been implemented in the LTR-style SmartMotors:
» Daisy-chain installation (multiple motors on the same network)
o Combitronic communications
» Fieldbus communications (CAN, CANopen, DeviceNet, PROFIBUS, etc.)
» |>C communications
» Special "AD1" I/O option (no ROF, ROC commands)
o COM 1 port (second serial port)

o External encoder

Commands Not Currently Supported
These commands are not currently supported in the LTR-style SmartMotor:
CAN related: CADDR=, CANCTL, CBAUD=, RCADDR, RCAN, RCBAUD

Sync motion commands (require Combitronic): ADTS, ATS, DTS, GS, PRTS, PRTSS, PTS, PTSS,
RPTSD, RPTST, TSWAIT, VTS

Commands associated with the second serial port: BAUD(1)=, CCHN on channel 1, ECHO1, ECHO_
OFF1, OCHN on channel 1, PRINT1, RBAUD(1), RGETCHR1, RLEN1, SILENT1, SLEEP1, TALK1,
WAKE1

Commands associated with the external encoder: Ai(1), Aij(1), Aj(1), Aji(1), Bi(1), Bj(1), CTR(1), ECS,
EIRE, ENC1, I(1), J(1), MC (limited to using SRC(2), SRC(-2)), MFO, MFDIV, MFMUL, MFR (limited to
using SRC(2), SRC(-2)), MS0, SRC(1), SRC(-1)

Other: ROC, ROF

For Further Information...

For further information on SMI software features, SmartMotor programming details, communication details,
motion details, a complete command reference and more, see the SmartMotor™ Developer's Guide.
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Troubleshooting

Troubleshooting

This section provides troubleshooting information for common problems. For additional support resources,
see: http://www.animatics.com/support.html.

Issue

Cause

Solution

Communication and Control Issues

Motor control power light does
not illuminate.

Control power is off, disconnected
or incorrectly wired.

Check that control power is connected to the proper pins
and turned on. For connection details, see Connecting the
System on page 28.

Motor does not communicate
with SMI.

Transmit, receive or ground pins
are not connected correctly.

Ensure that transmit, receive and ground are all connected
properly to the host PC.

Motor program is stuck in a
continuous loop or is disabling
communications.

To prevent the program from running on power up, use the
Communications Lockup Wizard located on the SMI
software Communications menu.

Motor circuit board temperature is
too cold.

If motor has been in environment of -40 degrees C or
below, circuit board may be too cold and internal heater
must be activated. For details, see Heater Power Require-
ments on page 26.

Motor disconnects from SMI
sporadically.

COM port buffer settings are too
high.

Adjust the COM port buffer settings to their lowest values.
This is done In the Windows Device Manager> Advanced
Settings dialog box for the associated COM port driver.

Poor connection on cable from
motor to PC.

Check the cable connections and/or replace it.

Power supply unit (PSU)
brownout.

PSU may be undersized for the application, which causes it
to brown-out during motion. Make moves less aggressive,
increase PSU size or change to a linear unregulated power
supply.

Motor stops communicating
after power reset, requires
redetection.

Motor does not have its address
set in the user program.

NOTE: Serial addresses are lost
when motor power is off or reset.

Use the SADDR or ADDR= command within the program to
set the motor address.

Red PWR SERVO light
illuminated.

Red LED indicates the drive stage
is OFF. This may be due to never
having been turned on yet, or a
critical shaft protection fault.

To discover the source of the fault, use the Motor View tool
located on the SMI software Tools menu.

Motor doesn't turn.

Faults not cleared and/or drive
enable not satisfied.

Clear faults (see Checking and Clearing the Status Bits on
page 40).

Satisfy the drive enable input (see Connecting the System
on page 28).

Common Faults

Bus voltage fault.

Bus voltage is too high for
operation.

Check servo bus voltage. Check for excessive regenerative
energy from motor due to no/insufficient shunt resistor.

Bus voltage is too low for
operation.

If motor uses the (separate drive and control power
supplies), ensure that both power supplies are connected
and are sized correctly for the motor.

Overcurrent occurred.

Motor intermittently drew more
than its rated level of current.
Does not cease motion.

Consider making motion less abrupt with softer tuning
parameters or lower acceleration profiles.

Excessive temperature fault.

Motor has exceeded internal PCB
temperature limit of 85°C. Motor
will remain unresponsive until it
cools down below 80°C.

Motor may be undersized or ambient temperature is too
high. Check motor sizing for the application in terms of
continuous rating. Consider adding heat sinks or forced air
cooling to the system.
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Troubleshooting

Issue

Cause

Solution

Excessive position error.

The motor's commanded position
and actual position differ by more
than the user-supplied error limit.

Increase error limit, decrease load or make movement less
aggressive. Also, ensure you are not voltage limited for the
torque at speed required. If running from less than 48 VDC,
check ratings for lower bus voltages and ensure the motor
is within required torque capacity.

Motor faults on position error
only after a certain amount of
time.

Motor is not accurately
corresponding to trajectory.

Motor sized incorrectly.

Check motor sizing for the application in terms of
continuous rating. Also, ensure you are not voltage limited
for the torque at speed required. If running from less than
48 VDC, check ratings for lower bus voltages and ensure
the motor is within required torque capacity.

Historical positive/negative
hardware limit faults.

A limit switch was tripped in the
past.

Clear errors with the ZS command.

Motor does not have limit switches
attached.

Configure the motor to be used without limit switches by
setting their inputs as general use.

Programming and SMI Issues

Several commands not
recognized during compiling.

Compiler default firmware version
set incorrectly.

Use the Compiler default firmware version option in the SMI
software Compile menu to select a default firmware version
closest to the motor's firmware version. In the SMI software,
view the motor's firmware version by right-clicking the
motor and selecting Motor Properties.
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